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Key information

Teaching

1 × weekly lecture (2 in weeks 1 and 2) on theory
1 × weekly practical class (2 in weeks 1 and 2) about  and 

Assessment

2 × 24-hour Take Away Papers (TAPs)
TAP 1: 30%
TAP 2: 30%

1 × Report (40%)
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Part 1: Introducing  and 
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Free software environment for statistical analysis and graphics
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Free software environment for statistical analysis and graphics

A free integrated development environment (IDE) for 
You use  as a way to interact with 

Install  and forget about it until such time that you need to update it
Install 
Set up  to suit your personality and enjoy your status as rad data scientist hipster
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Why ?
Transferable skills
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Why ?
Transferable skills

 is the most widely used data analysis software

Reproducible science

Cutting edge

One stop shop

 is amazeballs
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Starting up 
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Try it! Colour scheme
Windows

Tools > Options
MacOS

Tools > Global Options
RStudio > Preferences
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Try it! Pane locations
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Packages

16 / 68

Installing and loading packages

Install the package from CRAN

You need to install the package into ’s repository of packages on your computer.
Every time you update or re-install  you need to re-install packages to use them.
install.packages("package_name")
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Installing and loading packages

Install the package from CRAN

You need to install the package into ’s repository of packages on your computer.
Every time you update or re-install  you need to re-install packages to use them.
install.packages("package_name")

Load the package

To use a particular package in a current session load it from the repository.
library(package_name)
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Try it!
Execute install.packages("readr") in the console.
Execute install.packages("remotes") in the console.
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Installing the discovr package

remotes::install_github("profandyfield/discovr")
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Part 2: Interacting with  and 

Interacting with 
The console (boo!)

Type commands at the console prompt
Bad for reproducibility/your sanity
Great for getting help, trying things out
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Interacting with 
The console (boo!)

Type commands at the console prompt
Bad for reproducibility/your sanity
Great for getting help, trying things out

Script �les (meh!)
Great for reproducibility
Bad for integrating analysis into documents

 markdown document (hooray!)
A document that combines marked-up text and code
'Knits' to a nicely-formatted .html, .docx or .pdf (LaTeX required) �le.
Great for reproducibility
Great for integrating analysis into documents
All coursework submitted as html �le

Open the �le my_�rst_markdown.Rmd and click  to 'knit' the document.
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Inserting code chunks
Windows

ctrl + alt + i
Code > Insert Chunk

Mac

cmd + opt + i (⌘ + ⌥ + i)
Code > Insert Chunk
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Creating objects
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Try it
In my_�rst_markdown.Rmd create this code chunk

energy_tib <- eddie_tib[c("energy", "valence")]

Click  to execute the code in the code chunk
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Try it
In my_�rst_markdown.Rmd create this code chunk

energy_tib <- eddie_tib[c("energy", "valence")]

Click  to execute the code in the code chunk

Click  to execute all previous code chunks

Add the second line to the code chunk and click 

energy_tib <- eddie_tib[c("energy", "valence")]
energy_tib
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Functions

mean(variable_name, ... arguments/options ...)
mean(variable_name, na.rm = TRUE, trim = 0)
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Try it
In your my_�rst_markdown.Rmd �le

Insert a code chunk, type the �rst command into it and execute.

mean_energy <- mean(energy_tib$energy)
mean_energy

Click  to execute the code in the code chunk
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Try it
In your my_�rst_markdown.Rmd �le

Insert a code chunk, type the �rst command into it and execute.

mean_energy <- mean(energy_tib$energy)
mean_energy

Click  to execute the code in the code chunk

Insert a second code chunk, type the second command into it and execute.

plot(energy_tib)

Click  to execute the code in the code chunk

Click  to knit the document.
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Try it
Move one of your newly-created code chunks to before the code chunk called subset_data.

Click  to knit the document.
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Try it
Move one of your newly-created code chunks to before the code chunk called subset_data.

Click  to knit the document.

Knitting Tips

Code chunks are knitted in the order they appear in the markdown document.

Make sure you create objects BEFORE you try to use them.

Do NOT include install.packages() in markdown �les or the package will be installed every time
you knit the document!

Execute install.packages() commands at the command line
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Part 3: More  Markdown
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Code chunk options
echo=FALSE: the code will be evaluated but not reproduced in the knitted document.
eval=FALSE: the code will not be evaluated.
include=FALSE:  will evaluate the code but neither the code nor output are displayed in the
knitted document.
results="hide": the code will be evaluated and displayed in the knitted document but the output will
be omitted.
Include fig.width=9 and fig.height=5 to set the dimensions of an image

Obviously replace 9 and 5 with the values you want
Use results = 'asis' when creating tables from code/output
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Try it!
Using the code chunks we have already created
Change the code chunk headers to include echo=FALSE, re-knit the document and compare the result.
Repeat this process but including eval=FALSE

33 / 68

Markdown

# Level 1 heading
## Level 2 heading
### Level 3 heading
#### Level 4 heading

 Markdown: headers
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Markdown

# Level 1 heading
## Level 2 heading
### Level 3 heading
#### Level 4 heading

Knitted text

Level 1 heading

Level 2 heading

Level 3 heading

Level 4 heading

 Markdown: headers
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Markdown

* This is the first bullet point
  + this is a sub-bullet
  + so is this
* This is the second bullet
  + This is a sub-bullet
    - A third layer of bullet madness
    - It had to be done
* This is the third main bullet

 Markdown: lists

35 / 68

Markdown

* This is the first bullet point
  + this is a sub-bullet
  + so is this
* This is the second bullet
  + This is a sub-bullet
    - A third layer of bullet madness
    - It had to be done
* This is the third main bullet

Knitted text

This is the �rst bullet point
this is a sub-bullet
so is this

This is the second bullet
This is a sub-bullet

A third layer of bullet madness
It had to be done

and this is the third bullet

 Markdown: lists
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Markdown

*italic text*
**bold text**
Text^superscript^
Text~subscript~

 Markdown: emphasizing text
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Markdown

*italic text*
**bold text**
Text^superscript^
Text~subscript~

Knitted text

italic text

bold text

 Markdown: emphasizing text

Textsuperscript

Textsubscript
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 Markdown: images
![Caption for image](filepath_for_image)

![Figure 1: my lovely spaniel]
(media/milton_circle_2019.png)
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 Markdown: images
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![Figure 1: my lovely spaniel]
(media/milton_circle_2019.png)

Figure 1: my lovely spaniel
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 Markdown: hyperlinks
[text_describing_link](url)

Markdown

The **discovr** package is a collection of interactive tutorials for learning R. Get it
from [www.discovr.rocks/discovr/](https://www.discovr.rocks/discovr/)
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 Markdown: hyperlinks
[text_describing_link](url)

Markdown

The **discovr** package is a collection of interactive tutorials for learning R. Get it
from [www.discovr.rocks/discovr/](https://www.discovr.rocks/discovr/)

Knitted text

The discovr package is a collection of interactive tutorials for learning R. Get it from www.discovr.rocks/discovr/
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 Markdown: equations

Markdown

We can include the linear model in its own paragraph like this:

$$ Y_i = b_0 + b_1X_i + \epsilon_i $$
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 Markdown: equations

Markdown

We can include the linear model in its own paragraph like this:

$$ Y_i = b_0 + b_1X_i + \epsilon_i $$

Knitted text

We can include the linear model in its own paragraph like this:

Yi = b0 + b1Xi + ϵi
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Tables

Raw markdown

tap_tib

## # A tibble: 1,740 × 9
##    id    intervention efficacy did_bhv id_school time_cat intention time_num positivity
##    <chr> <chr>           <dbl>   <dbl> <chr>     <chr>        <dbl>    <dbl>      <dbl>
##  1 zy56g Group               3       0 school_1  baseline        35        0          5
##  2 xt30h Leaflet             3       1 school_1  baseline        36        0          3
##  3 st59q Group               4       0 school_1  baseline        34        0          4
##  4 vh02j Group               7       1 school_1  baseline        33        0          2
##  5 vn97y Leaflet             3       1 school_1  baseline        31        0          3
##  6 av87d Leaflet             5       1 school_1  baseline        36        0          4
##  7 nu84x Leaflet             3       0 school_1  baseline        33        0          6
##  8 zr06y Group               7       1 school_1  baseline        34        0          5
##  9 ls25l Leaflet             2       0 school_1  baseline        32        0          3
## 10 zp67x Group               5       0 school_1  baseline        35        0          2
## # … with 1,730 more rows
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Tables

Using results = 'asis' and kable()

tap_tib %>% 
  knitr::kable(caption = "Table 1: My nice table", digits = 2)

Table 1: My nice table
id intervention ef�cacy did_bhv id_school time_cat intention time_num positivity

zy56g Group 3 0 school_1 baseline 35 0 5

xt30h Lea�et 3 1 school_1 baseline 36 0 3

st59q Group 4 0 school_1 baseline 34 0 4

vh02j Group 7 1 school_1 baseline 33 0 2

vn97y Lea�et 3 1 school_1 baseline 31 0 3

av87d Lea�et 5 1 school_1 baseline 36 0 4
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Try it!
In your markdown �le create a level 1 header that reads 'About me'

Write a sentence or two about yourself using bold and italic somewhere

Create a level two heading 'My favourite things’

Within that section write a list of �ve of your favourite things. Include a URL to one of them.

(It could be books, movies, bands, songs, statisticians).
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Part 4: Workflow in 
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A �le created by  with the extension .Rproj

Stores information about the containing folder
Restores the previous state of the project (i.e. what documents/tabs were open)
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 project files
A �le created by  with the extension .Rproj

Stores information about the containing folder
Restores the previous state of the project (i.e. what documents/tabs were open)

Opening a project �le sets the working directory to the folder containing the project �le

You can use relative �le paths
The project will work on any machine you care to use
You can share your project folder with others and it’ll work for them

Use project �les!
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Filepaths made easy (well, easier …)

Relative paths

If you use an  project, you can use relative paths

tap_tib <- readr::read_csv("../data/tap_parenting.csv")
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Filepaths made easy (well, easier …)

Relative paths

If you use an  project, you can use relative paths

tap_tib <- readr::read_csv("../data/tap_parenting.csv")

The here package

If you use an  project, here::here() returns the project folder

Text within here() returns the folder or �le within the project folder that matches the text
tap_tib <- here::here("data/tap_parenting.csv") %>% readr::read_csv()
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library(here)
here::here()

## [1] 
"/Volumes/alpha_lacertae/documents/academic/teaching/disc_stats_module/disc_stat_presentations"

here::here("data")

## [1] 
"/Volumes/alpha_lacertae/documents/academic/teaching/disc_stats_module/disc_stat_presentations/data"

here::here("data/tap_parenting.csv")

## [1] 
"/Volumes/alpha_lacertae/documents/academic/teaching/disc_stats_module/disc_stat_presentations/data/tap_pa
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./data/my_funky_data.csv

../data/my_funky_data.csv

Get organized!

C:/Users/andyfield/Documents/my_new_project/data/my_funky_data.csv
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Creating a project: File > New Project
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Try it!
Create an  project called my_adventr on Sussex One Drive
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Try it!
Create an  project called my_adventr on Sussex One Drive

Within it create folders called

data
r_docs
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Try it!
Create an  project called my_adventr on Sussex One Drive

Within it create folders called

data
r_docs

Create a markdown �le

Use the File > New File > R Markdown … menu
Save it to the r_docs folder with the name sample_tap.Rmd
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Now, let’s save some data
On CANVAS go to Files > data_�les

Download the sample TAP data (tap_parenting.csv)

Copy the �le into the data folder of your project
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Part 5: Tidyverse

The tidyverse
A set of packages built upon a common philosophy of data science

52 / 68

The pipe operator (%>%)

metallica

## [1] "Lars"  "James" "Kirk"  "Rob"
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The pipe operator (%>%)

metallica

## [1] "Lars"  "James" "Kirk"  "Rob"

Multiple commands:

metalli_core <- subset(metallica, metallica != "Rob")
metalli_core <- sort(metalli_core)

Nested commands:

metalli_core <- sort(subset(metallica, metallica != "Rob"))

Piped commands:

metalli_core <- metallica %>%
  subset(., metallica != "Rob") %>%
  sort(.)
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Piped commands

metalli_core <- metallica %>%
  subset(., metallica != "Rob") %>%
  sort(.)

metalli_core

## [1] "James" "Kirk"  "Lars"
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 Style (Wickham, 2014)
 is case sensitive. In code chunks use lower case wherever possible

Variable and function names should be lowercase with an underscore (_) to separate words

Names should be concise and meaningful
A variable representing children’s’ anxiety levels might be named child_anxiety
scores_on_the_child_manifest_anxiety_scale is meaningful but too long, and ca is concise but not
meaningful

Place spaces around all operators (=, +, -, <-) to make code easier on the eye!

My practice: use suf�xes that identify types of objects. Some examples

_tib to denote a tibble (more them later), e.g. anx_tib for a tibble of data relating to anxiety)
_mod to denote a model (e.g., anx_mod for a model in which child anxiety is predicted)
_lm to denote a model built using lm()
_out to denote output (e.g., anx_out contains the summary output from the above model
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Messy vs. Tidy data

Messy data (aka 'wide' data)

What IBM SPSS Statistics uses

Each row represents a unique case/entity
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Messy vs. Tidy data

Messy data (aka 'wide' data)

What IBM SPSS Statistics uses

Each row represents a unique case/entity

Tidy data (aka 'long' data)

What many (but not all)  functions require

Each row represents an instance of the outcome measure
Rows code information about that 'instance'
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Are invisible people mischievous?

Placed participants in an enclosed community
riddled with hidden cameras
Measured how many mischievous acts
participants performed in a week
Manipulated whether or not there was access
to an invisibility cloak

Tidy data example
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Independent design

12 participants given an invisibility cloak
12 participants not given an invisibility cloak
A random sample of N = 7 from each group is
shown
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Independent design

12 participants given an invisibility cloak
12 participants not given an invisibility cloak
A random sample of N = 7 from each group is
shown

id cloak mischief

Anupama No cloak 1

Collin No cloak 5

Darrell No cloak 4

Kinaana No cloak 5

Steven No cloak 2

Tyler No cloak 6

Vanessa No cloak 6

Conan Cloak 6

Devante Cloak 7

Jerry Cloak 5

Kathryn Cloak 2

Sage Cloak 3

Shajee'a Cloak 4

Tamara Cloak 8
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Repeated measures design

12 participants given an invisibility cloak for one
week
During a different week they did not have an
invisibility cloak
A random subsample of N = 7 participants is
displayed
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Repeated measures design

12 participants given an invisibility cloak for one
week
During a different week they did not have an
invisibility cloak
A random subsample of N = 7 participants is
displayed

id cloak mischief

Anupama No cloak 1

Anupama Cloak 3

Collin No cloak 5

Collin Cloak 6

Darrell No cloak 4

Darrell Cloak 5

Kinaana No cloak 5

Kinaana Cloak 5

Steven No cloak 2

Steven Cloak 4

Tyler No cloak 6

Tyler Cloak 5

Vanessa No cloak 6

Vanessa Cloak 8
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tap_tib <- here::here("data/tap_parenting.csv") %>%
  readr::read_csv()

tap_tib

60 / 68

tap_tib <- here::here("data/tap_parenting.csv") %>%
  readr::read_csv()

tap_tib

tap_parenting.csv
id intervention ef�cacy did_bhv id_school time_cat intention time_num positivity

aa54j Group 7 1 school_7 baseline 28 0 1

aa54j Group 7 1 school_7 1 month 46 1 5

aa54j Group 7 1 school_7 6 months 29 6 2

ac09v Group 4 1 school_6 baseline 54 0 5

ac09v Group 4 1 school_6 1 month 48 1 5

ac09v Group 4 1 school_6 6 months 59 6 5

ad17o Lea�et 6 1 school_7 baseline 26 0 2

ad17o Lea�et 6 1 school_7 1 month 28 1 5

ad17o Lea�et 6 1 school_7 6 months 26 6 2

ad43a Group 3 1 school_6 baseline 57 0 4
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Part 6: Tips and good habits

Getting help
To get help, use the help() function or ?

help(thing_you_want_help_with)
?thing_you_want_help_with

The  help �les are frequently incomprehensible to mere mortals, but they are getting better!

Tip: Execute help commands at the command line

Do NOT include help() of ? in R markdown �les

Try it!

Access the help �les for the mean() function, by executing:

?mean

62 / 68

Using a ‘setup’ code chunk
Use a setup code chunk that

Sets global options for all of your code chunks
Loads all of the packages you plan to use (in alphabetic order)
Loads any data that you plan to use
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Using a ‘setup’ code chunk
Use a setup code chunk that

Sets global options for all of your code chunks
Loads all of the packages you plan to use (in alphabetic order)
Loads any data that you plan to use

knitr::opts_chunk$set(echo = TRUE, warning=FALSE, message=FALSE)

library(here)
library(kableExtra)
library(tidyverse)

tap_tib <- here::here("data/tap_parenting.csv") %>%
  readr::read_csv()
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Part 7: Getting the most from practical classes

Practical classes
The practical classes are based on a package of interactive tutorials called discovr that I wrote

You work at your own pace
You can work with friends/peers to support each other
Tutors will wander around giving you one-to-one help when you need it
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The discovr package

Installing discovr

if(!require(remotes)){
  install.packages('remotes')
}
remotes::install_github("profandyfield/discovr")
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Running a tutorial

library(discovr)
learnr::run_tutorial("name_of_tutorial", package = "discovr")
learnr::run_tutorial("discovr_03", package = "discovr")
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Suggested workflow
Create an  project called my_adventr

Within it create folders called data and r_docs
Save all of the data �les for the tutorials (on Canvas) into the data folder
Save the �le tutorial_template.Rmd into your r_docs folder
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Suggested workflow
Create an  project called my_adventr

Within it create folders called data and r_docs
Save all of the data �les for the tutorials (on Canvas) into the data folder
Save the �le tutorial_template.Rmd into your r_docs folder

Run a tutorial and open it in a separate window

Create a learning journal for the tutorial

Open the �le tutorial_template.Rmd and save it with a name related to the tutorial
As you work through the tutorial, copy the code you've written in the tutorial into code chunks in the R
markdown �le
Make notes (for example, anything you didn't understand at �rst, or things to help you remember what
you did and why you did it). This will help with your re�ective statements
Save the markdown �le for future reference, and/or knit it into an html document

Watch the video at https://youtu.be/FhoYCsZttGc
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Getting started with ,  and R Markdown

Professor Andy Field

 @profandy�eld

 www.youtube.com/user/ProfAndyField/

 www.discoveringstatistics.com

 www.milton-the-cat.rocks

 www.discovr.rocks

https://www.discovr.rocks/discovr/
https://youtu.be/FhoYCsZttGc


Key information

Teaching

1 × weekly lecture (2 in weeks 1 and 2) on theory
1 × weekly practical class (2 in weeks 1 and 2) about  and 

Assessment

2 × 24-hour Take Away Papers (TAPs)
TAP 1: 30%
TAP 2: 30%

1 × Report (40%)

2 / 68



Part 1: Introducing  and 



4 / 68



5 / 68



6 / 68



7 / 68



Free software environment for statistical analysis and graphics

A free integrated development environment (IDE) for 
You use  as a way to interact with 

Install  and forget about it until such time that you need to update it
Install 
Set up  to suit your personality and enjoy your status as rad data scientist hipster
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Why ?
Transferable skills

 is the most widely used data analysis software

Reproducible science

Cutting edge

One stop shop

 is amazeballs
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Starting up 
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Try it! Colour scheme
Windows

Tools > Options
MacOS

Tools > Global Options
RStudio > Preferences
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Try it! Pane locations
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Packages
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Installing and loading packages

Install the package from CRAN

You need to install the package into ’s repository of packages on your computer.
Every time you update or re-install  you need to re-install packages to use them.
install.packages("package_name")

Load the package

To use a particular package in a current session load it from the repository.
library(package_name)
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Try it!
Execute install.packages("readr") in the console.
Execute install.packages("remotes") in the console.
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Installing the discovr package

remotes::install_github("profandyfield/discovr")
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Part 2: Interacting with  and 



Interacting with 
The console (boo!)

Type commands at the console prompt
Bad for reproducibility/your sanity
Great for getting help, trying things out

Script �les (meh!)
Great for reproducibility
Bad for integrating analysis into documents

 markdown document (hooray!)
A document that combines marked-up text and code
'Knits' to a nicely-formatted .html, .docx or .pdf (LaTeX required) �le.
Great for reproducibility
Great for integrating analysis into documents
All coursework submitted as html �le

Open the �le my_�rst_markdown.Rmd and click  to 'knit' the document.
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Inserting code chunks
Windows

ctrl + alt + i
Code > Insert Chunk

Mac

cmd + opt + i (⌘ + ⌥ + i)
Code > Insert Chunk
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Creating objects
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Try it
In my_�rst_markdown.Rmd create this code chunk

energy_tib <- eddie_tib[c("energy", "valence")]

Click  to execute the code in the code chunk

Click  to execute all previous code chunks

Add the second line to the code chunk and click 

energy_tib <- eddie_tib[c("energy", "valence")]
energy_tib
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Functions

mean(variable_name, ... arguments/options ...)
mean(variable_name, na.rm = TRUE, trim = 0)
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Try it
In your my_�rst_markdown.Rmd �le

Insert a code chunk, type the �rst command into it and execute.

mean_energy <- mean(energy_tib$energy)
mean_energy

Click  to execute the code in the code chunk

Insert a second code chunk, type the second command into it and execute.

plot(energy_tib)

Click  to execute the code in the code chunk

Click  to knit the document.
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Try it
Move one of your newly-created code chunks to before the code chunk called subset_data.

Click  to knit the document.

Knitting Tips

Code chunks are knitted in the order they appear in the markdown document.

Make sure you create objects BEFORE you try to use them.

Do NOT include install.packages() in markdown �les or the package will be installed every time
you knit the document!

Execute install.packages() commands at the command line
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Part 3: More  Markdown
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Code chunk options
echo=FALSE: the code will be evaluated but not reproduced in the knitted document.
eval=FALSE: the code will not be evaluated.
include=FALSE:  will evaluate the code but neither the code nor output are displayed in the
knitted document.
results="hide": the code will be evaluated and displayed in the knitted document but the output will
be omitted.
Include fig.width=9 and fig.height=5 to set the dimensions of an image

Obviously replace 9 and 5 with the values you want
Use results = 'asis' when creating tables from code/output
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Try it!
Using the code chunks we have already created
Change the code chunk headers to include echo=FALSE, re-knit the document and compare the result.
Repeat this process but including eval=FALSE
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Markdown

# Level 1 heading
## Level 2 heading
### Level 3 heading
#### Level 4 heading

Knitted text

Level 1 heading

Level 2 heading

Level 3 heading

Level 4 heading

 Markdown: headers
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Markdown

* This is the first bullet point
  + this is a sub-bullet
  + so is this
* This is the second bullet
  + This is a sub-bullet
    - A third layer of bullet madness
    - It had to be done
* This is the third main bullet

Knitted text

This is the �rst bullet point
this is a sub-bullet
so is this

This is the second bullet
This is a sub-bullet

A third layer of bullet madness
It had to be done

and this is the third bullet

 Markdown: lists
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Markdown

*italic text*
**bold text**
Text^superscript^
Text~subscript~

Knitted text

italic text

bold text

 Markdown: emphasizing text

Textsuperscript

Textsubscript
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 Markdown: images
![Caption for image](filepath_for_image)

![Figure 1: my lovely spaniel]
(media/milton_circle_2019.png)

Figure 1: my lovely spaniel
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 Markdown: hyperlinks
[text_describing_link](url)

Markdown

The **discovr** package is a collection of interactive tutorials for learning R. Get it
from [www.discovr.rocks/discovr/](https://www.discovr.rocks/discovr/)

Knitted text

The discovr package is a collection of interactive tutorials for learning R. Get it from www.discovr.rocks/discovr/
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 Markdown: equations

Markdown

We can include the linear model in its own paragraph like this:

$$ Y_i = b_0 + b_1X_i + \epsilon_i $$

Knitted text

We can include the linear model in its own paragraph like this:

Yi = b0 + b1Xi + ϵi
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Tables

Raw markdown

tap_tib

## # A tibble: 1,740 × 9
##    id    intervention efficacy did_bhv id_school time_cat intention time_num positivity
##    <chr> <chr>           <dbl>   <dbl> <chr>     <chr>        <dbl>    <dbl>      <dbl>
##  1 zy56g Group               3       0 school_1  baseline        35        0          5
##  2 xt30h Leaflet             3       1 school_1  baseline        36        0          3
##  3 st59q Group               4       0 school_1  baseline        34        0          4
##  4 vh02j Group               7       1 school_1  baseline        33        0          2
##  5 vn97y Leaflet             3       1 school_1  baseline        31        0          3
##  6 av87d Leaflet             5       1 school_1  baseline        36        0          4
##  7 nu84x Leaflet             3       0 school_1  baseline        33        0          6
##  8 zr06y Group               7       1 school_1  baseline        34        0          5
##  9 ls25l Leaflet             2       0 school_1  baseline        32        0          3
## 10 zp67x Group               5       0 school_1  baseline        35        0          2
## # … with 1,730 more rows
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Tables

Using results = 'asis' and kable()

tap_tib %>% 
  knitr::kable(caption = "Table 1: My nice table", digits = 2)

Table 1: My nice table
id intervention ef�cacy did_bhv id_school time_cat intention time_num positivity

zy56g Group 3 0 school_1 baseline 35 0 5

xt30h Lea�et 3 1 school_1 baseline 36 0 3

st59q Group 4 0 school_1 baseline 34 0 4

vh02j Group 7 1 school_1 baseline 33 0 2

vn97y Lea�et 3 1 school_1 baseline 31 0 3

av87d Lea�et 5 1 school_1 baseline 36 0 4
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Try it!
In your markdown �le create a level 1 header that reads 'About me'

Write a sentence or two about yourself using bold and italic somewhere

Create a level two heading 'My favourite things’

Within that section write a list of �ve of your favourite things. Include a URL to one of them.

(It could be books, movies, bands, songs, statisticians).
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Part 4: Workflow in 



 project files
A �le created by  with the extension .Rproj

Stores information about the containing folder
Restores the previous state of the project (i.e. what documents/tabs were open)

Opening a project �le sets the working directory to the folder containing the project �le

You can use relative �le paths
The project will work on any machine you care to use
You can share your project folder with others and it’ll work for them

Use project �les!
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Filepaths made easy (well, easier …)

Relative paths

If you use an  project, you can use relative paths

tap_tib <- readr::read_csv("../data/tap_parenting.csv")

The here package

If you use an  project, here::here() returns the project folder

Text within here() returns the folder or �le within the project folder that matches the text
tap_tib <- here::here("data/tap_parenting.csv") %>% readr::read_csv()
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library(here)
here::here()

## [1] 
"/Volumes/alpha_lacertae/documents/academic/teaching/disc_stats_module/disc_stat_presentations"

here::here("data")

## [1] 
"/Volumes/alpha_lacertae/documents/academic/teaching/disc_stats_module/disc_stat_presentations/data"

here::here("data/tap_parenting.csv")

## [1] 
"/Volumes/alpha_lacertae/documents/academic/teaching/disc_stats_module/disc_stat_presentations/data/tap_pa
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./data/my_funky_data.csv

../data/my_funky_data.csv

Get organized!

C:/Users/andyfield/Documents/my_new_project/data/my_funky_data.csv
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Creating a project: File > New Project
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Try it!
Create an  project called my_adventr on Sussex One Drive

Within it create folders called

data
r_docs

Create a markdown �le

Use the File > New File > R Markdown … menu
Save it to the r_docs folder with the name sample_tap.Rmd
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Now, let’s save some data
On CANVAS go to Files > data_�les

Download the sample TAP data (tap_parenting.csv)

Copy the �le into the data folder of your project
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Part 5: Tidyverse



The tidyverse
A set of packages built upon a common philosophy of data science
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The pipe operator (%>%)

metallica

## [1] "Lars"  "James" "Kirk"  "Rob"

Multiple commands:

metalli_core <- subset(metallica, metallica != "Rob")
metalli_core <- sort(metalli_core)

Nested commands:

metalli_core <- sort(subset(metallica, metallica != "Rob"))

Piped commands:

metalli_core <- metallica %>%
  subset(., metallica != "Rob") %>%
  sort(.)
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Piped commands

metalli_core <- metallica %>%
  subset(., metallica != "Rob") %>%
  sort(.)

metalli_core

## [1] "James" "Kirk"  "Lars"
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 Style (Wickham, 2014)
 is case sensitive. In code chunks use lower case wherever possible

Variable and function names should be lowercase with an underscore (_) to separate words

Names should be concise and meaningful
A variable representing children’s’ anxiety levels might be named child_anxiety
scores_on_the_child_manifest_anxiety_scale is meaningful but too long, and ca is concise but not
meaningful

Place spaces around all operators (=, +, -, <-) to make code easier on the eye!

My practice: use suf�xes that identify types of objects. Some examples

_tib to denote a tibble (more them later), e.g. anx_tib for a tibble of data relating to anxiety)
_mod to denote a model (e.g., anx_mod for a model in which child anxiety is predicted)
_lm to denote a model built using lm()
_out to denote output (e.g., anx_out contains the summary output from the above model

55 / 68



Messy vs. Tidy data

Messy data (aka 'wide' data)

What IBM SPSS Statistics uses

Each row represents a unique case/entity

Tidy data (aka 'long' data)

What many (but not all)  functions require

Each row represents an instance of the outcome measure
Rows code information about that 'instance'
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Are invisible people mischievous?

Placed participants in an enclosed community
riddled with hidden cameras
Measured how many mischievous acts
participants performed in a week
Manipulated whether or not there was access
to an invisibility cloak

Tidy data example
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Independent design

12 participants given an invisibility cloak
12 participants not given an invisibility cloak
A random sample of N = 7 from each group is
shown

id cloak mischief

Anupama No cloak 1

Collin No cloak 5

Darrell No cloak 4

Kinaana No cloak 5

Steven No cloak 2

Tyler No cloak 6

Vanessa No cloak 6

Conan Cloak 6

Devante Cloak 7

Jerry Cloak 5

Kathryn Cloak 2

Sage Cloak 3

Shajee'a Cloak 4

Tamara Cloak 8
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Repeated measures design

12 participants given an invisibility cloak for one
week
During a different week they did not have an
invisibility cloak
A random subsample of N = 7 participants is
displayed

id cloak mischief

Anupama No cloak 1

Anupama Cloak 3

Collin No cloak 5

Collin Cloak 6

Darrell No cloak 4

Darrell Cloak 5

Kinaana No cloak 5

Kinaana Cloak 5

Steven No cloak 2

Steven Cloak 4

Tyler No cloak 6

Tyler Cloak 5

Vanessa No cloak 6

Vanessa Cloak 8
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tap_tib <- here::here("data/tap_parenting.csv") %>%
  readr::read_csv()

tap_tib

tap_parenting.csv
id intervention ef�cacy did_bhv id_school time_cat intention time_num positivity

aa54j Group 7 1 school_7 baseline 28 0 1

aa54j Group 7 1 school_7 1 month 46 1 5

aa54j Group 7 1 school_7 6 months 29 6 2

ac09v Group 4 1 school_6 baseline 54 0 5

ac09v Group 4 1 school_6 1 month 48 1 5

ac09v Group 4 1 school_6 6 months 59 6 5

ad17o Lea�et 6 1 school_7 baseline 26 0 2

ad17o Lea�et 6 1 school_7 1 month 28 1 5

ad17o Lea�et 6 1 school_7 6 months 26 6 2

ad43a Group 3 1 school_6 baseline 57 0 4
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Part 6: Tips and good habits



Getting help
To get help, use the help() function or ?

help(thing_you_want_help_with)
?thing_you_want_help_with

The  help �les are frequently incomprehensible to mere mortals, but they are getting better!

Tip: Execute help commands at the command line

Do NOT include help() of ? in R markdown �les

Try it!

Access the help �les for the mean() function, by executing:

?mean
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Using a ‘setup’ code chunk
Use a setup code chunk that

Sets global options for all of your code chunks
Loads all of the packages you plan to use (in alphabetic order)
Loads any data that you plan to use

knitr::opts_chunk$set(echo = TRUE, warning=FALSE, message=FALSE)

library(here)
library(kableExtra)
library(tidyverse)

tap_tib <- here::here("data/tap_parenting.csv") %>%
  readr::read_csv()
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Part 7: Getting the most from practical classes



Practical classes
The practical classes are based on a package of interactive tutorials called discovr that I wrote

You work at your own pace
You can work with friends/peers to support each other
Tutors will wander around giving you one-to-one help when you need it
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The discovr package

Installing discovr

if(!require(remotes)){
  install.packages('remotes')
}
remotes::install_github("profandyfield/discovr")
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Running a tutorial

library(discovr)
learnr::run_tutorial("name_of_tutorial", package = "discovr")
learnr::run_tutorial("discovr_03", package = "discovr")
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Suggested workflow
Create an  project called my_adventr

Within it create folders called data and r_docs
Save all of the data �les for the tutorials (on Canvas) into the data folder
Save the �le tutorial_template.Rmd into your r_docs folder

Run a tutorial and open it in a separate window

Create a learning journal for the tutorial

Open the �le tutorial_template.Rmd and save it with a name related to the tutorial
As you work through the tutorial, copy the code you've written in the tutorial into code chunks in the R
markdown �le
Make notes (for example, anything you didn't understand at �rst, or things to help you remember what
you did and why you did it). This will help with your re�ective statements
Save the markdown �le for future reference, and/or knit it into an html document

Watch the video at https://youtu.be/FhoYCsZttGc
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